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This Tutorial 

Tutorial Objective 
The objective of this tutorial is to learn how to work with Labels in 3D using a combination of 
2D/3D symbols and placement techniques. 

 

Tutorial Overview 
Labels are important to any map, be it a 2D map or a 3D map.  Labels can be used to identify 
streets or any type of element or theme (thematic attribution or statistics) within a map. 

 

A 3D map where labels are used to identify streets and traffic light type 

 

In GeoMedia
 
3D, labels can be controlled using your GIS data and therefore can be dynamic. 

That is, labels can reflect feature class attribution and if the attribution changes within a feature 
class, the associated labels will change.  In this tutorial, you are going to learn how to use 
attribute-based symbology to identify traffic light types and streets within the Honolulu area. 

 

Tutorial Data Set 
The exercises outlined in the GeoMedia 3D tutorials make use of specific data sets.  Specifically, 
the GeoMedia 3D tutorial data sets include:  vector sources (point, line, and area features), raster 
sources (aerial photographs in GeoTIFF format), and elevation sources in ERDAS Imagine and 
USGS SDTS formats. 

 

Tutorial Text Conventions 
There are several conventions used throughout the tutorial: 

 Ribbon bar items are shown as: On the Aaa tab, in the Bbb group, click Ccc. 



viii   

 Dialog box names, field names, and button names are depicted using Bolded Text. 

 Information to be entered, either by selecting from a list or by typing, is depicted using 
Italicized Text. 

 

Tutorial Prerequisites 
There are no prerequisites for making use of this tutorial; however, having a basic understanding 
of the GeoMedia Desktop will be helpful in expediting the execution of certain steps within this 
tutorial.   



 

   

Hovering Labels above the Section 1:  
Surface 

Section Objective 

The ability to control labels using attribution can be useful for creating 3D thematic maps.  In this 
section, you will couple attribution with display properties to create labels to depict the type of 
traffic light being displayed. Namely, in this section you will learn how to: 

 Review attribution that is associated with a record within a feature class. 

 Use the Label command within GeoMedia Desktop to insert a label at each traffic light 
location. 

 Use the 3D Style Properties to hover the traffic light label one meter above the surface. 

 Use the 3D Style Properties to control the aspect position so that the label faces upright 
at all times regardless of the viewing angle. 

 Use offset options to place labels at a specific offset distance from 3D symbols. 

You must be connected to the Internet to complete this exercise as the default content file makes 
use of a TerraGate® connection to serve imagery and terrain information to the 3D map window. 

 

Tools Used 

The Toggle 3D command and Style commands are used in this section. 
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 Using the Replace with 3D Exercise 1:
Object Property 

Objective: 
The objective of this exercise is to learn how to make used of the Replace with 3D object 
properties within the Style Properties dialog to replace a 2D symbol with a 3D model. 

Task 1: Launch GeoMedia and Toggle to 3D 

1. Use your mouse and desktop controls to navigate to C:\GeoMedia 3D 
Tutorial\GeoWorkspaces. 

2. Double click Exercise 6a.gws.  This action will start GeoMedia Desktop and open 
the GeoWorkspace called Exercise 6a. 

 

This GeoWorkspace has two legend entries (Traffic_Lights and Tax_Parcels). As in other 
tutorial GeoWorkspaces, please note that a Nominal map scale of 1:1,000 is used, the 
Traffic_Lights legend entry Style Scaling is set to Paper, and the point symbol size is set to 4 
Point. 

In this case, these combinations of settings lead to a symbol size that is small for the current 
scale, but these settings will yield appropriate-sized symbols as you zoom in.  When you select 
one or more entries, the highlighted symbols too will be of an appropriate size. 

3. On the 3D tab, in the View group, click Toggle 3D to convert the current 2D map 
window and contents to a 3D map window. 

 

As you can see, the Traffic_Lights and Tax_Parcels legend entries 
were automatically placed in the 3D map window. 
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Task 2: Review Attribution 

Attributes are an integral part of GIS features as the act as metadata for features. Some feature 
can have a few attributes while others can have many. 

1. Use the navigation tools to locate a street intersection that has both a single and a 
triple traffic light, and then zoom in on this location (similar to the example provided 
below) so that when the labels are added to the view, you will be able to see the 
results clearly. 

 

2. On the Home tab, in the Selection panel, click Select Tool to enable the selection 
tool; then select one of the traffic light point features and display the Properties 
dialog box (that is, once the selection tool has been enabled, double click near the 
base of one of the Traffic_Lights features in the map window). 

 

The Traffic_Lights feature class contains an attribute called Type. 
The Type attribute contains a value representing the type of traffic 
light at each specific location. 

3. Click OK to close the Properties dialog box. 

Task 3: Understand the Replace with 3D Object Property 

The Replace with 3D objects property allow you to make references to 3D models that are stored 
on your computer on a network disk. 

1. Double click the icon of the legend entry Traffic_Lights to display the Legend Entry 
Properties dialog box. 

2. Click the Properties button to display the Style Properties dialog box. 

3. Click the 3D Settings tab to bring this tab to the forefront. 

 

In this case, the Replace with 3D object option has been set up to 
drive which XPL file is displayed based upon the contents of the 
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Type attribute. Specifically:  

If the contents of the Type field contains the text Triple then use 

C:\GeoMedia 3D Tutorial\3D Symbols\3D Street Furniture\Triple 
Traffic Light (XPL)\3_Lane_1X_Turn.xpl 

else use 

C:\GeoMedia 3D Tutorial\3D Symbols\3D Street Furniture\Single 
Traffic Light (XPL)\Single_Traffic_Light.xpl. 

4. Click OK to close the Style Properties dialog box. 

5. Click OK to close the Legend Entry Properties dialog box. 
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 Adding Labels to the 3D Map Exercise 2:
Window Using an Attribute 

Objective: 
The objective of this exercise is to learn how to use an attribute to place a label within the 
GeoMedia 3D map window. 

Task 1: Use the Insert Label Command 

1. On the Vector tab, in the Annotation group, click Text and Label > Insert Label to 
display the Insert Label dialog box. 

2. Use the Label features in drop-down list to specify the feature class Traffic_Lights. 
The Traffic_Lights feature class is located in the connection named 
SamplePointFeaturesFor3DSymbols. 

 

3. Click on the Type entry in the Attributes list to specify that the contents of this 
attribute will be used to drive the contents of each label. This action will populate the 
Layout and Query name fields.  Your dialog box should look similar to the example 
provided below. 
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4. Use the Query name field to set the output name to Traffic Light Labels.  

 

5. Click the Style button to display the Select Style dialog box.  

6. Use the Size field to set the size of the text to 22 pt. 

 

7. Click the Properties button to display the Style Properties dialog box. 

8. Ensure the Display halo check box is checked, and then use the corresponding 
Color control to set the color of the halo to white.  
Halo size is not currently honored and therefore you do not need to set this option. 
The system will automatically create a halo for you using an internal size value. 

 

9. Click OK to close the Style Properties dialog box. 

10. Click OK to close the Select Style dialog box. 

11. Click OK to close the Insert Label dialog box. 

Task 2: Examine the Results 

The system should display your labels based upon the setting you have specified and your 3D 
map window should contain labels similar to those shown below. 
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If you feel that your 3D symbols are a bit dark, you can make use of the Sun and Date/Time 
commands in the Illumination group to brighten these objects. Remember, as outlined in the 
introductory tutorial, you will either have to check the Use fixed local time or set the Time Zone 
in the 3D Options dialog in the Effects tab. 

Task 3: Place Labels Upright and Relative to the Surface 

Labeling in a 3D environment can differ from labeling in a 2D environment in that in some 
instances you may not want to place a label on the surface (ground), but have the label hover 
above the ground relative to an object's geospatial location. 

 

In this particular case, we are going to make use of the 3D Settings tab to change the location of 
the label and hover it above the ground so that it always faces you regardless of viewing location. 

1. Double click on the icon of the legend entry Traffic Light Labels to display the 
Legend Entry Properties dialog box. 

2. Click the Properties button to display the Style Properties dialog box. 

3. Click the 3D Settings tab to bring this tab to the forefront. 

4. Click on the Use relative altitude based on option to enable it. 

5. Ensure the corresponding field for the Use relative altitude based on option is set 
to Surface. 



10  Hovering Labels above the Surface 

 
 

 

In this case, we are going to use the Use relative altitude based on option in tandem with the 
Use offset of field to offset the text 2 meters from the surface. 

The Use offset of list box allows you to enter a value, pick a numeric attribute, or define an 
expression. 

If you enter a value, the value entered controls the offset height of every label (for example, you 
could use this option to hover every label 5 meters above the surface). 

If you select a numeric attribute, the value of the attribute is used to control the offset height of 
each label individually. 

Finally, you can control the offset dynamically using the Expression options. Here you can define 
an expression and the resulting value or values are used to control the offset of each label. 

6. Ensure the Use geometry Z values check box is checked. 

7. Enter a value of 2 into the Use offset of control and set the corresponding units of 
measure to m. 

8. Finally, click on the Display facing upright radio button so that the resulting labels 
will face you regardless of viewing point.  Your 3D options should look similar to the 
sample provided below. 

 

9. Click OK to close the Style Properties dialog box. 

10. Click OK to close the Legend Entry Properties dialog box. Your labels should look 
similar to those presented in the example below. 
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11. Explore the results using the navigation tools.  You may notice that in some cases 
the text is interfering with the 3D symbol (that is, some labels are being cut off by the 
3D symbol).  You can minimize this problem by using offset values. 

Task 4: Offset Label Location from Surface 

You may notice during your exploration of the results that in some cases some labels are being 
cut off by a 3D symbol.  You can minimize this interference by offsetting the text from the symbol 
location. 

1. On the Analysis tab, in the Attribute group, click Queries to display the Queries 
dialog box. 

2. Click the Properties button to display the Query Properties dialog box. This dialog 
box can be used to control certain display properties for the labels query you created 
in the steps outlined above. 

3. Ensure the Offset horizontally by check box is checked. 

4. Enter a value of 2.5 into the Offset horizontally by field and set the corresponding 
units of measure to m. 

 

5. Click OK to close the Query Properties dialog box. 

6. Click Close to close the Queries dialog box.  
Your labels should look similar to those presented in the example below.  Notice that 
the labels are now offset from the 3D symbols and no longer interfere with the 3D 
symbols. 

 

7. Explore the results using the navigation tools. 
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Task 5: Exit GeoMedia Desktop 

You have completed this exercise. You can now exit GeoMedia Desktop and run through the next 
exercise. Given that you may want to revisit this exercise, it is recommended you do not save any 
of your changes and can therefore restart the exercise with a clean GeoWorkspace. 

1. Click the Close icon in the upper-right corner of the GeoMedia Desktop application 
window to exit GeoMedia Desktop.  The system displays a warning dialog box. 

2. Click No. 

 

 

 



 

   

Creating Street Labels Using Section 2:  
Display Scale Properties 

Section Objective 

In the previous section, you learned how to place labels relative to point symbols; however, we 
did not review how to make use of display scale to control when and how labels are displayed 
based upon display scale.  If this is not addressed, labels are displayed at a single size 
regardless of map scale and as a result, labels can actually impede one's ability to read the map. 
For example, if you zoom out using the labels we created in the exercise above, the labels will 
eventually cover a good portion of the map window. 

      

Example of how labels can adversely affect a map window (that is, labels can dominate a map window view). 

This adverse effect can be controlled using the Style Scaling property in tandem with the display 
scale and font size properties.  In this exercise, you will learn how to make use of these 
properties and to control how and when labels are displayed. 

You must be connected to the Internet to complete this exercise, as one of the base content files 
used makes use of a TerraGate® connection to serve imagery and terrain information to the 3D 
map window.In this section you will learn how to: 

 
 Use the Paper setting within GeoMedia Desktop in tandem with the Nominal Map Scale 

to control the display size of your labels so that they are displayed at an appropriate size 
for a given display scale. 

 Use the Display Scale property to control when labels appear and disappear from view. 

 

Tools Used 

The Toggle 3D command and Display Properties commands are used in this section. 
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 Reviewing Advanced Style Exercise 1:
Properties 

Objective: 
The objective of this exercise is to understand how advanced properties can be used to improve 
visualization in the GeoMedia map window. 

Task 1: Launching GeoMedia Using a GeoWorkspace 

In this particular case, GeoMedia Desktop will be started using the GeoWorkspace that has been 
provided as part of this tutorial. 

1. Use your mouse and Windows desktop controls to navigate to C:\GeoMedia 3D 
Tutorial\GeoWorkspaces. 

2. Double click on Exercise 6b.gws. This action starts GeoMedia Desktop and opens 
the GeoWorkspace called Exercise 6b. 

 

This GeoWorkspace has three legend entries: Tax_Parcels, Labels of Street_Centerlines, and 
Street_Centerlines. 

Task 2: Understand Scale Range 

GeoMedia allows to control when features toggle on and off within a map window. This toggling is 
driven by scale ranges. When a feature class meets the criteria set by the scale range the feature 
is displayed. 

1. Right click on the Labels of Street_Centerlines and choose Display Scale Range. 
This will display the Scale Range dialog box for the selected legend entry. 

2. With this scale range setting, labels will toggle on when the view display scale is 
between 1:1 and 1:5,000. 

3. Click OK to close the Scale Range dialog box. 

4. Right click anywhere in the 2D map window. This will display the context menu. 

5. Select the Display Properties entry to display the Display Properties dialog box. 

6. Notice that Nominal map scale is set to 1:1,000. 
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7. Click Close to close the Display Properties dialog box. 

 

It is important to remember that the nominal map scale is used in 
tandem with the Paper setting and font size (that is, when the Style 
Scaling is set to Paper, the fonts size will scale to reflect the relative 
distance to and from the nominal map scale). 

8. Right click on the Labels of Street_Centerlines and choose Style Scaling.  Notice 
that the Paper option is checked. 

 

With all of these properties set, the system should now effectively 
display labels when viewing the data in the 3D window. 

9. On the 3D tab, in the View panel, click Toggle 3D to convert the current 2D map 
window and its contents to the 3D map window. 

10. Use the navigation controls to zoom in and out. 

You should notice that the labels toggle off when the display scale is greater than approximately 
1:5000 and that when the labels toggle on, the font size changes and labels look good regardless 
of how much you zoom in. 

 

Display scale is greater than approximately 1:5000 and therefore no labels are displayed. 
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Display scale is approximately 1:2500 and therefore labels dynamically change and are displayed using an appropriate font size. 

 

 

Display scale is approximately 1:1000 and therefore labels dynamically change and are displayed using an appropriate font size. 

 

Display scale does not work exactly the same when you are in a 3D window.  When in a 3D 
window, the display scale varies; that is, the scale is not a constant throughout.  For example, the 
display scale of a map varies with each location within the view. 
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In the example above, the scale at location A is approximately 1:1,200, while the scale at location 
B is approximately 1:120,000. Given this variability, the system attempts to estimate when items 
should be toggled on or off. 

For additional information about display scale and how it can be used, see the GeoMedia 3D 
Help. 

11. Explore the results using the navigation tools. 

Task 3: Exit GeoMedia Desktop 

You have completed this exercise. You can now exit GeoMedia Desktop and run through the next 
exercise. Given that you may want to revisit this exercise, it is recommended you do not save any 
of your changes and can therefore restart the exercise with a clean GeoWorkspace. 

1. Click the Close icon in the upper-right corner of the GeoMedia Desktop application 
window to exit GeoMedia Desktop.  The system displays a warning dialog box. 

2. Click No. 

 

 

 

 

 


